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CADSIM Plus Tutorial

Learning Objectives & Outcomes

This tutorial will teach you all of the basic steps that you need to know to
create your first simulation model using CADSIM Plus simulation
software.

Requirements

To successfully complete the lessons in this tutorial  you should have a
working knowledge of process chemistry and control, and you should be
comfortable using Microsoft Windows and personal computers. You will
need the full version of the CADSIM Plus software installed on your
computer.

Learning objectives

The lessons in this tutorial will introduce you to the three main operating
modes of CADSIM Plus:

• Drawing Mode - used to draw a process flowsheet, which is the basis
of a CADSIM Plus process model

• Specification Mode - used to specify chemistry, process
relationships, and controls

• Run Mode - used to perform simulation calculations, tune controllers,
and solve the process model

You will need to be comfortable using all three of these modes in order to
do process simulation with CADSIM Plus.

Learning outcomes

When you have completed the lessons in this tutorial, you will have
learned how to:

• Use CADSIM Plus drawing tools to draw a process flowsheet
• Define process chemistry for a small process model
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• Add results formats for displaying simulation output on your process
flowsheet

• Add an animation to your flowsheet drawing
• Specify process variables, chemical relationships and reactions, and

set up controllers
• Run the simulation and tune a PID tank level controller

Tutorial document conventions

1. When you see a notation that looks like this: Tools > Options > Snap
settings, it means, ‘Select the Tools menu by clicking it with your mouse,
then select Options and then select Snap settings.’

2. When you are asked to select a menu item or a button, it means you
should move the mouse cursor over the item, and then click the left mouse
button to select it.

3. When you are asked to type a particular piece of text into a text field,
the text that you must type appears inside double quotation marks, like
this: ‘Overflow’.
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Lesson 1: Draw a Process Flowsheet

About lesson 1

The source data of a CADSIM Plus process simulation model is contained
in a flowsheet drawing. CADSIM Plus includes a drawing mode, which
you will use to create a process flowsheet. This flowsheet is also the
interface that you will use to interact with the model while the simulation
is performing calculations.

Learning objectives

When you have completed Lesson 1, you will know how to:

• Start a new drawing
• Insert parts into your drawing
• Move around the drawing using navigation tools
• Draw process lines and process units (polygons)
• Add text to drawings and complete the layout

Before you begin

You will create a new simulation drawing called CHEST.DRA. This will
be a simple tank level control model. You will create it in the
CSPlus\Working folder.

If this tutorial has been done previously on this computer, you should
delete, rename or move the existing CHEST.DRA file to a new folder
before you begin.

Step 1: Open a new drawing

1. Start the CADSIM Plus software (Select Start > Programs >
CADSIM Plus > CADSIM Plus).

2. Select File > Open and type ‘CHEST.DRA’in the filename field to
open a new drawing in the CSPlus\Working folder.

3. If you are reopening CHEST.DRA, select it from the previously
opened files list located at the bottom of the File menu.

When you started CADSIM Plus, the program opened in Adjust Mode.
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This is the mode that you will use to change the attributes of existing
objects in your drawing. While in Adjust Mode the arrow cursor    can be
used to move the anchor point    to a new position (but don’t move it
now).

The anchor point is the place where the next item will be inserted, or
where your drawing will continue. The default location of the anchor point 
is x = 0 mm, y = 0 mm. It is also known as the drawing origin. You will
use this anchor point in Step 2.

Step 2: Insert a border

A border helps you lay out your drawing by providing a perimeter for your
work. You should choose a border that matches the paper size that you
will use when you print your drawing. Insert a border at the drawing
origin, and then draw inside it.

1. With the anchor point on the drawing origin, select the Insert Part
button  that is located in the toolbar.

2. In the dialog box which appears, select Standard: and then select
Borders from the drop-down menu in the panel on the right.

3. Now select A4.BOR from the list that appears in the center panel.
4. Click the Insert button, and then click the Finish button.

A drawing border will appear in the drawing window. The bottom-left
corner of the drawing should be located at the drawing origin.

Step 3: Navigate the drawing

Let’s assume that you want to change your view of the drawing. Your
current view is probably the bottom left-hand corner of the border that you
inserted in Step 2.

1. Maximize the drawing window by clicking the Windows maximize
button  in the top right-hand corner of the window to see more of
your drawing.

2. Now, select the Zoom Extent button  to center the border inside
the drawing window.

3. Next, select the Navigator button  to open the Navigator for easy
viewing and zooming around the drawing.

4. Try changing the position and view of the border by clicking on the
positioning  and zooming  buttons.
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5. To finish Step 3, position your drawing so that the upper left-hand
quadrant of the border is easily visible to you. You may close the
Navigator when you are finished.

You are now ready to begin drawing your flowsheet.

Step 4: Draw process lines

Process drawings are made from process lines which represent pipes, and
polygon shapes which represent process equipment, such as storage tanks,
heaters, and separators.

There are also non-process lines which you can use to beautify your
drawing, but which do not become part of the simulation model. The
border which you inserted in Step 2 is an example of non-process lines.

In this step, you will draw some process lines.

1. Move the Adjust Mode cursor    to the upper right-hand quadrant
within the border, and push and hold the left mouse button until the
anchor point is relocated.

2. Select the Process Line button  to turn on process line drawing
mode. 

 Note: While in drawing mode, the cursor is a pencil image with a
rubber band that follows your mouse movements. One end of the line
snaps to the snap points. The other end remains anchored.

3. Move the mouse so that the active
point (moving point) of the cursor
moves to the right six squares on the
guidelines (equals 60 mm), then click
the left mouse button to draw a
horizontal process line.  Note that an
arrowhead is automatically placed to
show the direction of flow.

4. Move the mouse 10 mm down and
click to draw a second (vertical) line
connected to the first.

For more information about drawing lines
and relocating the active point of the
drawing cursor, select Help > Contents >



CADSIM Plus - Getting Started

12

How do I.... > Draw Lines? in the CADSIM Plus Help system.

Step 5: Draw a process unit

Next, you will create a tank by drawing a rectangular polygon shape
connected to the vertical pipe inlet line that you completed in Step 5.

1. Move the anchor point of the cursor 10 mm to the left of the vertical
line’s endpoint. Push and hold the left
mouse button to move the anchor point to
the new position.
2. Select the Polygon button  from the

toolbar.  This will activate the Polygon
drawing mode.

3. Move the mouse to the right about 20
mm and click to draw a horizontal
polygon line.

4. Move the mouse down 30 mm and
click to draw a vertical line.

5. Move the mouse up to the left 20 mm
and draw another horizontal line.

6. Move the mouse up 30 mm and draw
the final vertical line to finish a
rectangle

 Note: When the polygon is closed, a text dialog box will open
automatically. The reason for this is that each unit needs a unique
identifier and a module unit name for the simulation model.

7. Type the letters ‘#1 CHEST’. This
names the tank #1 and instructs
CADSIM Plus to choose the CHEST
(TANK) unit module.

8. Click the OK button to finish entering
text.

This completes the polygon and returns you
to process line drawing mode.
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Step 6: Complete the flowsheet drawing

When you finished entering text in Step 5, the cursor changed back to the
process line drawing tool. You may notice that CADSIM Plus has
automatically positioned the cursor on the side of the polygon, opposite
the inlet line.

1. Move the mouse 10 mm down from the bottom of the tank and click
to draw a line.

2. Move the mouse 60 mm to the right and draw a horizontal line for the
tank underflow.

3. Move the anchor point to the right side of the tank, slightly down, (5
mm) from the top.

4. Move the mouse 40 mm to the right and draw a line for the tank
overflow.

 Note: You now need to label the overflow line ‘OVERFLOW’. This is
one of the requirements for using the ‘CHEST’ or ‘TANK’ unit. See the
CADSIM Plus Help files for more information. A complete description of
all the unit modules in the CADSIM Plus libraries, including keyword
names and other requirements, can be found by selecting Help > Process
Modules.

5. Select the Process Text button  from the toolbar.

 Note: Process text is always attached to an object and labels it for the
simulation model. That is why you chose the icon that shows a line under
the letter ‘A’.

6. Move the selection cross hair cursor to approximately 10 mm above
the overflow line, about 10 mm to the right of the tank and click to
select the line using the left mouse button. The line should flash once.
If the tank flashes, click OK without typing anything, and try again.

7. Type ‘OVERFLOW’ in upper case (as shown) to label the line.
8.  Click OK.

 Note: The text tag ‘OVERFLOW’ is attached to the overflow line. If
you try to delete the text, the line will also be deleted.

This completes your simple flowsheet. In Lesson 2, you will define the
chemistry and material that flows into your tank and pipes.
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Lesson 2: Define Process Stream Chemistry

About lesson 2

Now that you have created your drawing, you need to create a Stream
Definition (SDEF) to describe the chemical components in your model.
The SDEF also defines the units of measure that are used in your model.
You will create your own process variable that is derived from other
variables. You will also include estimates or default values for your stream
variables.

Learning objectives

When you have completed Lesson 2, you will know how to:

• Create a new Stream Definition
• Define engineering units of measure
• Choose a stream type
• Add stream components
• Create a user-defined process variable
• Add estimates or default values for your stream variables

Step 1: Create a new stream definition

1. Click the Create Stream Chemistry button  in the toolbar.
2. Click the Create button to open the Stream Definition Wizard.

The visible area of the drawing will change to an enlarged view of a flask
icon that will contain your chemistry definition. A wizard appears that will
help you step through creation of your stream definition.

Step 2: Define engineering units of measure

The first page of the wizard allows you to define your engineering units of
measure.  In CADSIM Plus you can use a mixture of SI and American
units, or all of one or the other. 

1. Experiment by choosing various combinations of units of measure to
see the available units.

2. Click the Default SI Units button to reset all units of measure to
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metric.
3. Click the Next Page button to finish editing the Engineering Units of

Measure page.

Step 3: Choose a stream type

The Stream Type page is shown in the Stream Definition Wizard. You can
choose between Paper, Chemistry, Mineral, or Food stream types. Each of
these stream types includes a set of default variables, with some slight
variations.

 Note: Stream types are described in detail in the Help system, under
Module Libraries > CADSIM Plus Stream Types.

1. Select the default stream type called ‘PAPER’ and click the Next
Page button.

Step 4: Add stream components

The Components page is shown next. This is the page that allows you to
select stream variables for your model.

1. Click the expand  button beside ‘LIQUID’.
2. Select ‘WATER’ from the list of predefined variables that is shown.
3. Click the  button to add ‘WATER’ to the ‘Selected Components’

list on the right.
4. Now click the collapse  button beside ‘LIQUID’ to collapse that list.
5. Click   beside the ‘INORGANIC’ list to expand it.
6. Select ‘User Defined’
7. Type ‘DISSOLVED’ in the text entry box that is shown.
8. Click the OK button to finish adding DISSOLVED to the selected

components list.
9. Click the   button beside ‘INORGANIC’ to collapse that list.
10. Select ‘TEMPERATURE’ and then click  to add it.

Review the stream chemistry text that appeared on the drawing as you
made each choice. The volumetric flow for your model will be in ‘l/s’. 
The dissolved solids concentration will be in ‘mass %’. The temperature
will be in ‘°C’.  The mass flow of both WATER and DISSOLVED will be
in ‘kg/s’.
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Step 5: Create a user-defined variable

Let’s assume that you have some plant volumetric flow rates in USGPM
(US Gallons Per Minute). Although you may want to work primarily in SI
units of measure, you want to add USGPM to your model. Consequently,
you will add a variable to each stream to calculate USGPM.  

1. Click the Next Page button to go to the Derived page of the Stream
Definition Wizard to build an equation which describes USGPM.

2. Leave the default equation type as ‘Linear’.
3. Click the Create Definition button
4. Type ‘USGPM’ and click OK.

 Note: You will want to multiply the volumetric flow in l/s by a constant
to get USGPM.

5. Click the Add Term button.
6. Select ‘VOLUMETRIC_FLOW (l/s)’ from the drop-down list.
7. Enter ‘15.85’ in the multiplier (*) field.
8. Leave the constant (+) value ‘0’.
9. Click the Finish button to complete the derived equation.

You have created a new variable called ‘USGPM’, that is derived from the
‘VOLUMETRIC_FLOW’, converting l/s to ‘USGPM’ by multiplying l/s
by 15.85.

Step 6: Add stream estimates

The final step of creating a stream definition is to provide estimates for all
stream component values.  The streams in your model will be initialized to
these values if you do not have a start file continuing initial values that
‘prime’ the model at start up. 

1. Click the Next Page button to move on to the Estimates page of the
Stream Definition Wizard.

2. The first variable that is visible in the drop-down box is ‘WATER’. 
Type ‘300’ for this variable in the text entry box below.

3. Click the Insert button.

 Note: This defines a mass flow estimate for ‘WATER’ in kg/s.

4. Select ‘DISSOLVED’ from the drop-down box and enter ‘15’ for
‘DISSOLVED’ (kg/s).
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5. Click the Insert button.
6. Finally, select ‘TEMPERATURE’ from the

drop-down box, and enter ‘50’ (°C).
7. Click the Insert button.
8. Click Finish to complete your stream

definition. 

This completes Lesson 2. You have now defined
the stream chemistry. In Lesson 3 you will learn
how to create and place results formats on your
drawing.
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Lesson 3: Create a Results Format

About lesson 3

In Lesson 3 you will create a ‘format’ or place holder that will be used by
CADSIM Plus to display simulation results on each stream in the model.

Formats are used to display variables that you have chosen on your model
drawing. When the simulation is run, these displays will be updated with
current simulation results. The drawing can be saved with these results so
that they can be plotted.

Learning objectives

When you have completed Lesson 3, you will know how to:

• Create a results format
• Add a results format to a process line
• Add results formats automatically to all remaining process lines

Step 1: Create a results format

Let’s say that you want to see volumetric flow rate, percent solids and
temperature on each stream.  Also, assume that you would like the display
of results to have the same number of decimal places and units of measure
as this example:

100 l/s 5.00 % 50 °C.

1. Click Add Format to Line   in the toolbar.
2. Click the New button.
3. Type,

# l/s #.## % #.#`C

into the text field between the (  ) brackets. As you type each set of #
characters, CADSIM Plus will automatically add another variable
choice to the dialog box.

 Note: The CADSIM Plus degree sign is the opening or single quote (`)
character that is located under the tilde (~) symbol on your keyboard. It
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will display as (°) on the CADSIM Plus drawing.

 Note: The # character represents any number of digits ahead of the
decimal point. Each # character after the decimal point represents a single
decimal place. Add more # characters after the decimal point to display
more digits.

You have created three place holders for variables in your new format.
Now, you must choose which variable is used for each of your three place
holders.

4. Select ‘VOLUMETRIC_FLOW (l/s)’ in the first drop-down field for
the first place holder.

5. Select  ‘DISS_SOL_CONC (%)’ in the second field for the second
place holder.

6. Select ‘TEMPERATURE (`C)’ in the third field for the third place
holder.

7. Click OK to finish creating the format.

Step 2: Add a results format to a process line

When the dialog box closes, you will have a floating format that will
‘stick’ to the various process lines as you
move your mouse pointer around the
drawing.

1. Move the mouse cursor so that the
format is close to the stream that you
labeled ‘OVERFLOW’.

2. Click to place this format close to the
start of the ‘OVERFLOW’ outlet of the
tank, as shown in the illustration
below.

Step 3: Add formats to remaining lines

You have placed one format on your drawing. In the next step, you will
place the same format on the rest of the streams in your drawing.

1. Click the Adjust Mode  button in the toolbar.
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2. Move the mouse cursor  to the top left-hand corner of the drawing.
3. Click and hold the left mouse button and move the mouse (click and

drag)  to pull a selection rectangle around the entire drawing.
4. Release the left mouse button to finish your selection. Ignore the

attribute inspector that appears.
5. Click the Add Format to Line  button in the toolbar.
6. Click Place to automatically add and position your format on the two

remaining streams in your drawing.
7. Click the  button in the toolbar to save your work.

You have now formatted your drawing for simulation results. In Lesson 4
you will learn how to add an animation to your drawing to enhance the
runtime display.
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Lesson 4: Insert an Animation

About lesson 4

In Lesson 4, you will learn a little bit about inserting drawing parts such as
animations into a CADSIM Plus drawing.

 Note: Runtime animations are used to visually convey information to
the user. For example, you will add a level bar to the CHEST in this lesson
that will show how full the tank is while the simulation is running. Any
CADSIM Plus drawing element attribute can be animated.

Learning objectives

When you have completed Lesson 4, you will know how to:

• Move the anchor point of a line
• Insert a drawing part
• Adjust the number of repetitions in an animation

Step 1: Move the anchor point of a line

Let’s assume that you want to visually monitor the fluid level in the
CHEST. An animation will graphically show the current tank level on the
drawing.

1. Click the Adjust Mode  button in the toolbar.
2. Move the mouse cursor  to the bottom line of the tank, 5mm (half

way between) the underflow outlet and the side of the tank.
3. Click and hold the left mouse button to move the anchor point  to

the selected location.

Step 2: Insert a drawing part

1. Click the Insert Part button  in the toolbar.
2. Select ‘Standard: Process’ from the drop-down ‘Part Library’ list.
3. Select ‘LevelBar.dra’ from the list in the middle of the Insert Part

dialog box.
4. Click the Insert button.
5. Click Finish.
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Step 3: Adjust the level bar indicator

Now you will adjust the level bar indicator to appear to have a maximum
height which is the same as the overflow line.

1. Click the Adjust Mode  button.
2. Click on the level bar to select it.
3. A ‘Line Pattern’ inspector will open, which contains the settings for

the level bar part.
4. Select the pattern ‘Repeats’ field, and edit ‘50’ to ‘100’ to extend the

level bar to near the top of the tank.
5. Click OK.
6. Click the  button in the toolbar to save your work.

You have now completed Lesson 4. In Lesson 5, you will specify the
process variables for your simulation model.
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Lesson 5: Specify Process Variables

About lesson 5

The next step in building your simulation model, is to specify relationships
for the variables that you have defined in your stream definition in Lesson
2. CADSIM Plus will guide you through this process by assessing your
drawing and prompting you to select variables and equation types. When
this process is complete, the model will be ready to run.

Learning objectives

When you have completed Lesson 5, you will know how to:

• Start simulation run mode
• Create a controller
• Specify free process variables
• Specify unit variables

To specify process variable relationships you must enter simulation mode.

Step 1: Start simulation run mode

1. Click the Run Simulation  button in the toolbar.

The results formats will be made invisible, the tank inlet line will blink, a
triangle will highlight the start of this line indicating it as a SOURCE unit,
and the ‘Specification Types’ dialog box will open. You will now create a
controller based on the tank’s incoming WATER flow.

Step 2: Create a controller

The premise of this simulation problem is tank level control. Let’s assume
that you want to have enough WATER to flow through the inlet stream to
maintain the LEVEL of the tank.  You will add a short cut controller,
which is a quick method of setting up a controller.
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 Note: If you cannot pick ‘LEVEL (vol %)’ from the drop-down
variable list in Step 2 (above), then there is a problem with your model
that has prevented CADSIM Plus from choosing the CHEST unit for
your tank. It has chosen the DEFAULT unit instead.

There are two common causes of this problem:

1. The text tag ‘OVERFLOW’ that you added to the model has been
attached to the CHEST polygon, instead of to the overflow line. To
fix this problem, repeat the tagging procedure and make sure that
you choose the overflow line.

2. When you named the CHEST polygon, you may not have left a
space between ‘#1’ and ‘CHEST’. To fix this problem, click to
select the text ‘#1CHEST’ and then edit it using the Text Inspector
to add the required space.

 Note: You could also use one of the advanced controller units found in
the CADSIM Plus standard library of process modules, but we will not do
that here.

1. Select the Flow PID Controller from the
‘Controllers’ section of the ‘Specification
Types’ dialog box (see illustration).

2. Leave the ‘Equation Type’ set to ‘direct
setting’.

3. Click the Place button.

 Note: You can now move the valve icon along
the inlet line. The icon will follow the mouse
cursor along the line and will flip to the top or
bottom as you move the mouse above or below the
line.

4. Click to place valve icon below the line.
5. You will now be given the measurement

device icon.  Move it close to the left side of
the tank until it flips and locks on to the tank.

6.  Click to place it on the left side of the tank.
7. Select ‘LEVEL (vol %)’ from the drop-down variable list.
8. Type ‘60’ in the numeric field.
9. Click Finish to complete your short cut controller.
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Step 3: Specify free process variables

Specify DISSOLVED

The tank inlet line will blink again, but this time the ‘Specification Types’
dialog box will request that you make a choice to satisfy the free variable
‘DISSOLVED’.

1. Select the ‘Local Specification or
Equation’ icon in the ‘Specifications’
section of the dialog.

2. Leave the ‘Equation Type’ set to
‘direct setting’.

3. Click the Place button.
4. Move the icon to the position that you

want on the inlet line.
5. Click the left mouse button to place the

icon.
6. Select ‘DISS_SOL_CONC (%)’ from

the drop-down variable list and enter
‘5’ as the desired percentage.

7. Click Finish to complete the
DISSOLVED specification.

Specify TEMPERATURE

The tank inlet line blinks again, but this time the ‘Specification Types’
dialog box will request that you make a choice to satisfy the free variable
‘TEMPERATURE’.

1. Select the ‘Local Specification or Equation’ icon in the
‘Specifications’ section of the dialog.

2. Leave the ‘Equation Type’ set to ‘direct setting’.
3. Click the Place button.
4. Move the icon to the position that you want on the inlet line.
5. Click the left mouse button to place the icon.
6. Select ‘TEMPERATURE (`C)’ from the drop-down variable list and

enter ‘50’ as the desired temperature in degrees C.
7. Click Finish to complete the TEMPERATURE specification.

You have now finished specifying the stream variables on the tank inlet
stream. Next, you will specify unit variables on the tank unit.
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Step 4: Specify unit variables

Specify MAX_VOLUME

The tank sides blink to show that the tank unit is now selected. The
‘Specification Types’ dialog box will request that you make a choice to
satisfy the free variable ‘MAX_VOLUME’.

1. Select the ‘Multiple Specifications or Equations’ icon in the
‘Specifications’ section of the dialog.

 Note: Multiple specification icons can contain more than one variable
within a single icon, which saves space on the drawing.

2. Select ‘direct setting’ from the ‘Equation Type’ drop-down menu list.
3. click the Place button.
4. Move the icon to a position on the left side of the tank.
5. Click the left mouse button to place the icon and enter ‘300’ for the

maximum volume of the tank.
6. Click Finish to complete the MAX_VOLUME specification.

Specify INITIAL_VOLUME

The ‘Specification Types’ dialog box now requests that you make a choice
to satisfy the free variable ‘INITIAL_VOLUME’.

1. Select the ‘Multiple Specifications or Equations’ icon in the
‘Specifications’ section of the dialog.

2. Leave the ‘Equation Type’ drop-down menu list set at ‘direct setting’.
3. Click the Place button.
4. Move the icon so that it is over top of the previous diamond-shaped

icon (that you placed for ‘MAX_VOLUME’) on the left side of the
tank.

5. Click the left mouse button to place the icon and enter ‘150’ for the
initial volume of the tank.

6. Click Finish to complete the INITIAL_VOLUME specification.

 Note: The multiple specification icon now has two variables specified
within it’s single icon.
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Specify HEAT_LOSS

The ‘Specification Types’ dialog box now requests that you make a choice
to satisfy the free variable ‘HEAT_LOSS’.

1. Select the ‘Multiple Specifications or Equations’ icon in the
‘Specifications’ section of the dialog.

2. Leave the ‘Equation Type’ drop-down menu list set at ‘direct setting’.
3. Click the Place button.
4. Move the icon so that it is over top of the previous diamond-shaped

icon (that you placed for ‘INITIAL_VOLUME’) on the left side of the
tank.

5. Click the left mouse button to place the icon and enter ‘0’ for the
HEAT_LOSS of the tank.

6. Click Finish to complete the HEAT_LOSS specification.

This completes the steps for specifying three unit variables on the tank
unit. Next, you will be prompted to specify variables for the outlets on the
tank.

Specify FLOW

Each of the two tank outlet lines will now blink. The ‘Specification Types’
dialog box now requests that you make a choice to satisfy the free variable 
‘FLOW’.

1. Select the ‘Local Specification or Equation’ icon in the
‘Specifications’ section of the dialog.

2. Select ‘direct setting’ from the ‘Equation Type’ drop-down menu list.
3. Click the Place button.

 Note: Since the ‘OVERFLOW’ line was drawn first, that is the default
line that this new icon appears on.  However, it would not make sense to
set the ‘OVERFLOW’ variable ‘FLOW’, because this line should only
become active when the tank volume has been exceeded.

4. Move the icon down to the lower side of the tank underflow line.
5. Click to place the icon.
6. Select ‘VOLUMETRIC FLOW (l/s)’ from the drop-down variable list

and enter ‘300’ l/s.
7. Click Finish to complete the FLOW specification.

Two SINK units are highlighted with triangles on the end points of the



CADSIM Plus - Getting Started

28

outlet streams.  These show streams which leave the process.

You are now asked to update the file before proceeding to simulation
mode. The simulation is now complete and ready to run.
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Lesson 6: Run the Simulation

About Lesson 6

Now that you have completed your simulation model, CADSIM Plus is
ready to run it in Simulation Mode. The process of switching from
Drawing Mode to Simulation Mode was completed in Lesson 5. Your
model is now ready to run.

You will use simulation mode to perform simulation calculations and to
control your model while it is running. You will learn how to start and
stop your simulation, how to create a strip chart to monitor a process
variable, and how to tune a PID controller.

Learning objectives

When you have completed Lesson 6, you will know how to:

• Get stream and equipment information
• Access controller and specifications settings
• Create a strip chart
• Start the simulation running
• Manipulate a controller
• Tune PID level control loops

Step 1: Get stream and equipment information

Before starting the simulation, try clicking on the various elements on the
drawing to view the runtime information dialog boxes:

View process line information

1. Click on any process line to show a ‘Stream Variables’ dialogue box.
You will see a list of all of the variables that were pre-loaded with the
estimates that you provided when you created the stream definition.

2. Scroll to the bottom of the list to see the derived variable USGPM.
3. Notice that the units of measure and the chemical components are the

ones that you chose when you created the stream definition.
4. Click OK to close the dialogue box.
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View equipment module information

1. Click on the ‘#1 CHEST’ tank to show its list of variables.
2. Click OK to close the dialogue box.

 Note: The Simulated Values have been initialized to the Dynamic Load
Module (DLM) default values for a CHEST unit. One simulation iteration
will be needed before actual calculated values are shown.

Step 2: Access controller and specification settings

1. Click to select the inlet water to tank level controller. You will see a
PID controller dialog box for ‘LEVEL’.

 Note: The controller setpoint can be manipulated, PID Settings can be
tuned, and the controller can be changed from Automatic to Manual so
that the inlet ‘WATER’ flow can be manipulated manually.

2. Click OK to close the PID controller dialog box.
3. Click to select one of the single specifications. You will see a dialog

box that is similar to the PID controller for ‘LEVEL’.

 Note: Only the direct setting value can be changed on specifications
because they are not controllers.

4. Click OK to close the specification settings dialog box.
5. Click to select the multiple specification icon (diamond shape) to

show its variables.

 Note: These settings can be edited, but don’t change anything now.

6. Click OK to close the multiple specification icon dialog box.

Step 3: Create a Strip Chart

1. Click the Create Strip Chart  button in the toolbar.
2. Move the mouse cursor to one side of the CHEST unit and click to

select it. A dialogue box will open with a list of all of the variables
that are associated with ‘#1 CHEST’. 

3. Select ‘LEVEL’ from the list of variables and click the Accept button
to create a strip chart.
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 Note: This strip chart will display successive simulated values for the
variable ‘LEVEL’ in the form of a trend chart.  Elapsed ‘Time’ is

displayed along the X-axis in minutes.  For
a more complete description of the chart
features and options, see the CADSIM Plus
Help documentation.

You will now create a second strip chart to
monitor the inlet makeup line flow.

4. Click the Create Strip Chart 
button in the toolbar.

5. Click to select the process line that
flows into ‘#1 CHEST’.

6. Select ‘VOLUMETRIC_FLOW’ from
the variable list and click the Accept
button to create a second strip chart.

You are now ready to start your process running in simulation mode.

Step 4: Start the simulation running

1. Click  the  Run  button in the toolbar. This will start the
simulation running.

 Note: The model will run freely while performing simulation passes. It
will execute all units, streams and controllers sequentially. When all of the
units, streams and controllers have be executed, it will repeat the process
until you pause the simulation. 

You will notice that in place of the results formats that you put on the
process lines, you will see current numbers displayed that have been
calculated by CADSIM Plus. Notice also that the level indicator within the
tank rises and falls with the changing tank level.

2. Click to select some of the process elements on the drawing to review
their dialogue boxes, which display current simulation results.

 Note: If your monitor resolution is low, you may wish to move or
minimize the strip charts to uncover portions of the drawing that are
hidden.
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Step 5: Manipulate a Controller

Change the setpoint

1. Click the ‘LEVEL’ control icon. The PID controller dialogue box
appears.

 Note: The PID controller setpoint can be changed while the
simulation is running. You can also set the controller to manual so
that you can control the flow manually.

2. Edit the ‘Setpoint’ text field to change the value from ‘60’%
to ‘50’%. You can also use the scroll bar to manipulate the
setpoint value.

3. Click OK to close the PID controller dialogue box.

 Note: The control will wander a bit, but will eventually settle
in on the new setpoint. You probably have noticed that the level
control demonstrated by this model is not the best that you have
seen. You will tune up the controller settings in Step 5.

4. Click the ‘LEVEL’ control icon again to reopen the PID
controller dialog box.

5. Change the setpoint back to ‘60’.
6. Click OK to close the PID controller dialogue box.

Manual control

1. Click to select the ‘LEVEL’ controller again.
2. Click the Manual radio button. The ‘Controlled’ variable text field

can now be edited.
3. Change the ‘Controlled’ variable from ‘300’ to ‘400’.
4. Click OK to close the PID controller dialogue box.

 Note: The tank will quickly overfill and the excess flow will be
diverted through the OVERFLOW stream.

5. Click to select the ‘LEVEL’ controller again.
6. Click the Automatic radio button.
7. Click OK to close the PID controller dialogue box.

The model will return to stability at its setpoint under automatic control.



CADSIM Plus - Getting Started

Copyright © 2003, Aurel Systems Inc. 33

Step 6: Tune PID Level Control Loops

The trial and error method of tuning this level controller is not very
efficient. You will now use the ‘Lambda Tuning’ method to tune the PID
parameters for your level controller.

 Note: You may wish to refer to the section Tuning Controllers in the
CADSIM Plus Help documentation.

KP can be calculated as a result of observations from a bump test. For level
control, KP is ()level / )time) / )flow. Consequently, a change in flow
will result in a continuously changing level (integrating action of a tank)

A bump test could be performed on the simulation by following this
procedure (don’t do this now):

• Put a strip chart on the tank’s inlet flow
• Put another strip chart on the tank’s level
• Set the level controller on manual
• Give the manually controlled flow a step change
• Observe the system response by reading the necessary values from the

strip chart for a selected )time to calculate KP

You can also calculate KP directly by assuming the ultimate bump test -
which is filling the tank.  In this case, )time is the time taken to fill the
tank:

It does not matter what flow we pick as it will cancel out later. Assume for
this calculation that the flow is 300 l/s.
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The signal normalizing ratio, SR can also be calculated.  Assume for this
calculation that the inlet flow has a maximum of 500 l/s.

Proportional Gain:

Assume that the process can withstand +/- swings in level of 25%.  From
the table of PID controller tuning equations, we get:

Some controller units use an overall proportional constant which is:

Integral Reset Time:

Substituting the equation,
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from the table of PID controller tuning equations, we get:

Differential Constant:

Since there is no dead time with your tank:

Consequently, you can try the following PID settings in your model:

• Proportional Gain = 20
• Reset Time  = 10
• Differential Constant = 0

This should result in much better level control. To implement these
changes to the ‘LEVEL’ PID controller settings:

1. Click to select the ‘LEVEL’ controller again.
2. Click the Settings button.
3. Edit the ‘Proportional Gain’ text field from

‘0.125’ to ‘20’.
4. Edit the ‘Reset Time’ text field from ‘5’ to

‘10’.
5. Leave the ‘Differential Constant’ text field to

‘0’.
6. Click OK to close the PID Settings dialog

box.
7. Edit the ‘Setpoint’ to a new number, such as

‘60’
8. Click OK.
9. Watch the response on the ‘LEVEL’ strip chart.

The response to changes in the ‘LEVEL’ setpoint should now be much
faster, without the oscillations that you previously saw in the tank level.
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 Note: These results can be generated easily by using the spreadsheet
TUNELEV.XLS (located in the CSPlus folder).  Enter the numbers 300,
1000, 300, 60, 100, 500, and 25 (respectively) into the green input fields to
get the expected result for this tutorial.

This completes Lesson 6.

Congratulations, you have drawn a flowsheet, constructed a simulation
model, run it, and tuned a PID controller. This concludes the CADSIM
Plus tutorial.


